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MYRIAD PLAYOUT V5 

First Look – v5.05.5 



INTRODUCTION 

 

This document has been written to act as a ‘first look’ at Myriad Playout v5. It will be a living document so 

as new features are released it will be updated to include them so look at the version number of Myriad 

Playout you are running and check back at broadcastradio.com/support for the latest version. 

Any software interface menus have been written in bold italics so look out of these. 

LICENSING 

 

The licensing engine like virtually everything in Myriad 

Playout v5 has been re-written and is now much easier 

and streamlined.  

When you first download a trial version from the 

Broadcast Radio website you can use it fully unrestricted 

for 4 days and then you can continue to use it for a total 

of 20 days in a time restricted mode.  

When you are ready to license the software you can either click 

Install License from the dialog box on startup of the application or to 

go Settings>License Details and click on Install/Uninstall License Key. 

 

 

 

 

 

 

From here you can copy and paste your 

License Key which normally you will receive 

on email, then click on Install. 
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When you click on Install the License Status 

will begin authenticating. Your machine 

must be connected to the internet in order 

for this authentication to occur. 

 

 

 

 

Once this authentication is complete you 

will receive a License Status notification as 

seen on the right. If you machines are not 

connected to the internet you can request 

license codes direct from Broadcast Radio 

and use the Load License window and 

navigate to your license file(s) in order to 

license your application.  



OVERVIEW/NEW FEATURES / SMARTINFO/ LAYOUT 

 

If you are upgrading from a previous version of Myriad Playout the interface will be recognizable with a few 

differences to naming and the default settings.  

The AudioWall is now called the MediaWall as each ‘Media Item’ can contain more than just a single piece 

of audio or no audio at all! 

Instant Carts are now Favourites but the Pad is still available and the Segue Editing and Voice tracking 

method remains the same (space bar is your friend!). 

 

 

SMART INFO PANEL 

 

The Smart Info Panel is a new feature that dynamically gathers and displays 'live' relevant information from 

various online sources relating to the active Artist(s) and Song selected in Myriad Playout. So, as you are 

playing the latest song by Sia, Smart Info will be displaying information about the artist, her discography, 

latest tweets, album art, year of release and more. 

The Smart Info Panel will attempt to display the following information for Artists and Songs. 

• Album Art 

• Year of Release 

• Official Wikipedia Page 



• Official Twitter Feed 

• Studio Note (time contextual notes you have added to the system) 

It’ll also show you the weather in your area. You can also 'pin' a Smart Info page so it will not automatically 

update if you spot something you want to talk about later or just show one source of information. 

Smart Info can also automatically populate certain information on song Media Items including Album Art 

and the Year of Release. 

MULTIPLE LAYOUTS 

 

Change the look and layout of Myriad Playout with a couple of clicks 

enabling you to focus on the task you need to do.  

At the moment you can choose from some pre-defined layouts but 

in the future you can design your own and place the Tiles wherever 

you wish. 

 

 

 

QUICK RECORDER 

 

 

The Quick Recorder is a new feature in Myriad Playout v5 designed to streamline the workflow of recording 

and editing a simple interview or phone call to just a few clicks. 

1. Click the record button. 

2. Do your recording / Interview your guest. 

3. Click on the Stop button. 

4. Click on the Process button - it will trim silence from the beginning and end, normalise the order, 

perform a dynamic process on the audio, re-normalise it (in case it has changed) and set the extro. 

5. Type in the Title. 

6. Click Save - the audio will be saved as a new Media Item ready to be played. 

  



ROTATE, SHUFFLE & LIST MEDIA ITEMS 

 

Media Items are no longer limited to a single piece of audio. You 

can quickly build special media items to perform a range of useful 

tasks. These include: 

Rotate Media - Each time the Media Item is played, the next piece 

of audio in a sequence is actually played. 

Shuffle Media - Each time the Media Item is played, a random 

piece of audio from a list is played. 

List Media - When the Media Item is played, all the listed audio will be played in sequence through a single 

Media Player. 

 

MEDIAWALL 

 
The MediaWall is a numeric wall of Media Items with each item often being an audio recording such as a  

song, jingle or promo but can contain one of the new Rotate, Shuffle or List Media Items detailed earlier or 

some other command.  The best way to imagine the MediaWall is as a large shelf and like a physical shelf, 

Media Items containing similar content can be clustered together in different areas to make locating things 

easier. The Jump buttons running along the top of the MediaWall allow you to get to these shelf locations 

quickly. 

The Media Items can contain a range of additional information such as text, pictures and timing 

information that is used by both Myriad Playout and the presenter. 

PLANNING YOUR MEDIAWALL 

 

The screenshot below shows the default ranges of Item Type on the MediaWall. You will see that Song 

Items have been given the range 10000 – 99999 and that the normalization used is different from the rest 

of the items. This will change the volume of anything which is imported into this range in a different way 

than if the song the imported into a different Media Item number. We would suggest you take a look at 

this and change to suit your station. 



 

 

The reason Links have been assigned to the beginning is, by default, whenever Myriad Playout starts up, it 

will automatically display Media Item Number 1 onwards which means that in this case, the station’s 

Jingles will be displayed. 

The Songs have been assigned to the other end of the MediaWall but this has been done to avoid putting a 

cap on the amount of Songs that we can add to the system. If we wanted to, we could add 50,000 Songs 

because there is nothing else on the MediaWall beyond the Songs area. 

In general, planning the layout of your MediaWall at an early stage is a very good idea as it offers a clear 

definition of where the audio you add to the system needs to go. 

GETTING AUDIO ONTO THE MEDIAWALL 

 

If you are moving from a previous version of Myriad Playout it is advisable to use the Myriad Playout Auto 

Updater Tool available at broadcastradio.com/support. This will import your former AudioWall data and 

Database settings across into your MediaWall and Database. 

RECORDING THE OUTPUT OF THE MIXER DESK 

 

If you have the rights to ‘edit’ a range of Media Items you can record into them. 

To quickly record click the red record button in the Media Item recorder to the 

right of the normal playout Media Item players. This will select the next free 

Media Item in the range and instantly start recording. There are some VU bars 

on the recorder to show you there is audio going in.  

You can also record by highlighting an empty Media Item (this will put a red highlight around the Media 

Item) and then use the Myriad Playout keyboard to select ‘Start Rec’. You can also right click on that empty 

Media Item and choose to record into this Media Item. 

You also have the option of clicking on ‘Edit’ once you have highlighted an empty Media Item to open it 

into the Editor where you can then click on the record button within the Audio Edit Area. 
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IMPORT  

 

To do this, right click on the empty Media Item you 

want to import into and select Import (Ctrl + i) you 

will then be asked to locate the audio file that you 

want to import.  

You can select a range of files by clicking on the first 

and then holding down the shift key and clicking on 

the last. You can also select individual files by 

holding down the Ctrl key and clicking on your file(s). 

 

 

IMPORT AUDIO: AUDIO EDIT AREA ON THE SMOOTHEDIT SCREEN. 

 

Another method for importing an audio file onto the 

MediaWall involves importing the audio directly into the 

destination Media Item via the SmoothEdit screen. To 

use this method, find an empty Media Item that you 

want to import into then click on the Edit button on the 

Home Tab of the MediaWall Tile or choose Edit on the 

right click menu. Then from the Home Tab in 

SmoothEdit click on the Import icon (see right).  

Navigate to the file you wish to import and click on open. This method only allows you to import one file at 

a time but does allow you to import audio files of multiple formats (e.g. MP2, MP3, WMA & OGG), plus it 

allows you to edit the audio, data and timing information directly after the audio has been imported. 

DRAG AND DROP FROM WINDOWS EXPLORER 

 

Open an explorer window and navigate to the file or files you wish to import. Click or highlight the file(s) 

you wish to import and drag them onto the first Media Item you wish the audio to be imported into. If you 

have selected multiple files and there is already an item in a MediaWall number it will ask you if you wish 

to overwrite that or jump over it to the next available Media Item. 

 

EDITING MEDIA ITEMS 

 

The editor allows you to edit audio media items, rotate, shuffle and list media items and also command 

items (coming soon). The most common Media Item is Audio. 



EDITING AUDIO ITEMS 

 

SmoothEdit the built-in audio editor is capable of the majority of audio work required within a typical radio 

station. You can integrate an external audio editor, such as Adobe Audition™, in the settings and any 

changes you make, once saved, will be written back to the MediaWall. 

TITLE, ARTIST & DESCRIPTION LINES 

 

This allows you to enter Title, Artist and Description details for the Media Item along with the content type 

and category and details of how it ends.  

You have 5 options for the ending:- 

Ends (E) – The Media Item comes to an abrupt end. 

Fades (F) – The Media Item fades out at the end. 

Sustain (S) – The Media Item ending is sustained for a period at the end. 

Slow Fade (SF) – The Media Item fades out over a longer period at the end. 

Not Specific (blank) – The ending has not been specified. 

To play just the end of the file you can click on the play icon to the right of the end selection box 

You can dig in further to the Media Item by using the ribbon tabs ‘Edit’ and ‘View’ to change, for example, 

the ‘custom colour’ for the background and text colour of the Media Item. 

TIME INFO PANEL 

 

The Time Info Panel is an essential part of an Audio Media Items information as it contains the Timing 

information that Myriad Playout will use when playing.  

The key timing events are:- 

Intro Start – The beginning of the Intro (the bit you can talk over). This is usually set to zero (beginning of 

the song) unless the song has a specific start that you do not want presenters or sweepers to clash with. 

Intro Mid - Intro Mid is used as a soft intro point that is visually displayed on screen in the Media Players as 

a line in the intro progress. It is used for maybe setting an earlier visual marker (when drum kicks in maybe) 

that you could opt to use to talk up to. For the majority of songs it won’t be used. 

Intro End – This is normally defined as the place in the song where you would want your DJ’s to stop talking 

or your sweepers to finish playing. Typically it is when the vocals start or maybe a drum beat kicks in. 

Hook Start – The Hook start marks the beginning of the Hook. The Hook is the most recognisable part of 

the Song and can be used as a ‘teaser’ for what is going to be played soon. Myriad Playout has the ability to 

play Hooks as part of an automated run so this is a useful addition to the Media Item.  

Hook End – This marks the end of the Hook. 



Extro – This is the point that Myriad Playout will start the next item when it is performing an automated 

segue. It is typically very close to the end of the song, maybe as it is fading out. 

To set them, click the small play button above the attribute you wish to set and then when it reaches the 

point you wish to set as that attribute click in the main box below. You can fine tune the timing use the << 

and >> icons either side of the small play button or type in the number box the timing information in 

hours:minutes:seconds:milliseconds format.  

You could also go into Full Audio Edit Mode and use the mouse to ‘drag’ these points around in the Audio 

Edit Area by moving the mouse cursor to the top of the marker (start or end) until the cursor changes to a 

hand icon, then using the left mouse button drag the marker left or right. 

SEARCHING FOR MEDIA 

 

SEARCH THE MEDIAWALL 

 

You can search either from the MediaWall or Library. In Myriad Playout v5 the search in the MediaWall has 

been sped up dramatically.   

To use Search from the MediaWall click the Search button on the Home Tab and you can choose to open 

the main search tab or perform a search based on the Media Item currently highlighted. You can also 

directly click on the ‘Search’ tab in the Ribbon. Type in a word or phrase you want to search for in the 

Search For box and either hit return or click on Search. 

The results are then listed in the Search Results window. From here you can drag the Media Item to a 

Player or directly into the Log or Favourites screen. You can also double click on an item in the Search 

Results window to jump to its position on the MediaWall. Every search window allows you to click on the 

column headers to sort by that aspect of the Media Item in A-Z or Z-A order or if you click on the Intro or 

Extro column by ascending or descending length. 

SEARCH THE LIBRARY  

 

Using the search within the Library gives you some more criteria that you can search against. You can 

search for items from a certain year if that information has been added in either Myriad Autotrack or to the 

MediaItem directly. You can look for items of a set duration or released between certain years. 

You may also wish to search only within a certain category which can be achieved by putting your criteria 

into the search box and performing a search. Then clicking on the desired category to narrow down the 

search.  

Previous searches are available from the dropdown menu to the right of the search box.  

The columns in the result window can be clicked on to re-order the data in A-Z or time or number 

ascending/descending order.  

 



  



PLAYING AUDIO 

 

This section will concentrate on the various ways in which Media Items can be cued into the Players ready 

to be played. This section will not cover playing Media Items from the other major sections of Myriad 

Playout and in particular how Media Items are played when using the Log screen. This will be covered in 

the Log Screen section of the documentation. 

DRAG N DROP 

 

One of the most commonly used methods for manually playing Media Items in Myriad Playout is to left 

click and drag the Media Item you want to play directly onto the desired Media Item Player and releasing 

the button whilst on it. The mouse cursor will change as you hover over the Media Item Players; release 

the left mouse button to ‘drop’ the Media Item into one of the Media Item Players. You can then use the 

Media Item Player’s play button to start playback of the Media Item. By default, you need to have your 

mouse cursor over the player for the transport controls to appear. You can change this if desired to always 

show them by going to View>Customise Personal Preferences and the Players tab. 

USING THE RIGHT CLICK MENU 

 

The right click menu provides an alternative way of manually playing a Media Item on the MediaWall. To 

play (or Cue) a Media Item using the right click menu, right click on the Media Item that you want to play 

and select ‘Play’. The Media Item will be loaded into the first free Media Item Player (usually lowest 

number first but this is configurable) and playback starts immediately. If you prefer, you can select ‘Cue’ 

and the Media Item will be loaded into the first free Media Item Player and the Media Item will be ready to 

be played manually by clicking on the Play button on the Media Item Player or using the hardware 

controller or button on mixer, if configured. 

DOUBLE CLICK 

 

You can also double click on a Media Item to play it in Myriad Playout. This method is not recommended 

for use in a live environment due to the imprecise nature of double clicking. When you double click on a 

Media Item, the Media Item is automatically loaded into the first free Media Item Player (again, usually the 

lowest number but this is configurable) and playback starts immediately. 

USING A KEYBOARD 

 

In addition to using the mouse, you can also use the keyboard to either cue or play Media Items from the 

MediaWall.  

<Ctrl>+ L Plays the highlighted Media Item on the Media Wall into the first available Media 

Item player 



<Ctrl>+<Shift> + L Cues the highlighted Media Item on the Media Wall into the first available Media 

Item player 

PLAY/CUE ONSCREEN BUTTONS 

 

On the Home Tabs of the Library and MediaWall Tiles there are Play and Cue Buttons which will work on 

the currently highlighted item on the appropriate tile. 

HARDWARE 

 

You may find your mixer desk has been setup so if you press a ‘GO’ button on the mixer on the fader which 

has a Myriad Playout source on it it will start to play whatever is cued up in that Media Player. For example, 

the SRM mixer is configured to enable button start of items in Media Item players. 

 

FAVOURITES 

 

Favourites are effectively just shortcuts to specific Media Items on your MediaWall.  

Favourites are linked to the number keys on a Hardware keyboard from Broadcast Radio which means that 

Favourites offer fast and simple access to key Media Items on your MediaWall. Myriad Playout allows you 

to configure Favourites in sets.  

If you have attached a Media Item to Favourite 1 and you then left click on it or touch it if using a 

touchscreen the Media Item attached to Favourite Media Item 1 will immediately load into a free Media 

Item Player (you can configure it to play from a preferred Media Item player if it is free) and begin 

playback. You can also left click and drag the item to your preferred Media Player. This makes Favourites 

ideal for playing commonly used jingles or liners as well as competition stabs, sound effects and pretty 

much anything else you will use on a regular basis.  

If when one instant Media Item is playing you fire another it will be loaded in the 

next available Media Item player by default. You can also choose Favourites to 

restart from the beginning if the same Media Item position is triggered twice in 

quick succession by clicking on the ‘Re-play Mode’ button.  

CREATING A FAVOURITE 

 

To add a Media Item to a Favourite position drag and drop it onto the position you want it to take. It will 

put a shortcut to this Media Item on your Favourite grid. To remove a favourite either drag and drop 

another Media Item onto it or click on the Clear button and left click on the item you want to remove. 

New in Myriad Playout v5 you can create Rotate, Shuffle and List Media Items and these can be added to 

your Favourites so you could create a Sweepers Rotate Item and whenever you need a sweeper click on 

your favourite and a different one will play each time. 



THE LOG 

 

The Log is your running order and is split into whole hours xx:00:00 – xx:59:59. The log works in two modes 

-  Live Assist and AutoFade.  

Live Assist will allow you to put Red stops at the ends of items enabling you to talk between the items 

which will be automatically loaded into the set Media Players. It will also help you with your back timing to 

the end of the hour.  

AutoFade will go through the log playing the items selected and fading or dropping them in order to finish 

the last item at the moment the next hour begins. 

 

The log is in Standby mode unless Live Assist or AutoFade is clicked on. In Standby you can add items to a 

log and even drag and drop items from the log into a Media Player. When you do click on Live Assist or 

AutoFade the item which is currently selected in the log will load into the first available Media Player and it 

will be waiting for the Go Button ❶ to be pressed either on screen or via a Hardware Controller. 



Once Go has been activated the log will begin to playout.  If in Live Assist mode you can click on 

the Green circle ❷ to change it to a Red Square which will mean after that item has played it 

will stop and wait for you to press play on the next item or click on the Go icon ❶ again before 

starting again. 

You can also go from Live Assist mode into Auto fade by clicking on Auto fade ❸ and this will 

automatically Green any items which previously had a red square at the end of them. 

CREATING/MODIFYING A LOG FOR PLAYOUT 

 

For most users there will always be a log ready to playout however you can create and modify the log (if 

rights allow). Below are the main ways to do this. 

ADDING OR REPLACING ITEMS 

 

You can easily add new items to the log by dragging and dropping them from the MediaWall, Library or 

Favourites windows. Drag the item onto the Log Tile and then release the mouse button when the black 

line is in the desired place. You can also go to the Edit Tab of the Log Tile and click on Add Item and on 

some types a mini item browser will come up and you can pull them from there. 

To replace an item, select it and 

click on the Replace Item button 

under the Edit Tab in the Log Tile 

which will bring up a pop out 

window of the Media Library. Find 

the item you would like to replace it 

with and click on OK and it will 

replace the previously highlighted 

item.  

 

 

 

 

 

 

MOVING ITEMS 

 

To change the order of the items in the Log left click on the item you wish to move and with the button 

held down move the mouse pointer to the position you would like the item to be placed. Whilst moving an 



item you will see a black bar appear between items to indicate where the item will be placed when you 

release the button. 

DELETING ITEMS 

 

You have two options for deleting items. A Soft Delete or a permanent delete/removal.  

A Soft Delete greys out the item in the Log (see below) enabling you to 

easily change your mind and click it again to re-instate the item and Delete 

which will remove the item from the Log entirely. To Soft Delete choose 

the Log item and from the Home Tab in the Log click on the icon above the 

words Soft Delete. If you click on the text or the disclosure triangle next to 

the text you can choose to permanently delete the item from the log. Within the Edit Tab in the Log both 

types of deletion are available as separate buttons. You can also delete items using the right click menu 

(see below). 

 

You are only removing the item from the log and not deleting the actual file itself from the MediaWall.  

RIGHT CLICK MENU 

 

When you right click on an item in the log the menu on the 

right appears.  

 

 

 

 

 

  



SEGUE EDITING AND VOICE TRACKING 

 

Whenever you use the Segue Editor it will use a sound output for the player and a sound input for the 

recorder both of which you view/change within Settings>Media Engine setting.  

The role of the Segue Editor is to alter and ‘fine tune’ the way that Myriad Playout will perform an 

automated segue. 

Segue Editor (Pop-Out) Mode 

 

Within the default layout you can get 

to this mode by clicking on the SegEdit 

button on the Home Tab of the Log 

Tile. An extra undocked window will 

appear (see right) which is used for 

editing automated segues and this can 

also be used for recording VoiceTracks. 

It also allows you to adjust the ‘fade’ 

period of the outgoing item and the 

start point and any fade in of the next 

item. You can adjust these by left 

clicking on the green line to create a 

node point and dragging a node up and down to create volume envelopes. If you want to start again you 

can choose to Reset Volumes by clicking on it. When happy, click on the disk icon ❸ or to discard your 

changes, click on the arrow icon ❷. Move the mouse pointer and right click to play from that point in the 

item or segue. 

The red line on the outgoing item is its extro point and the green highlighting around the incoming item 

shows its intro duration. You can resize this window to suit your needs. Clicking on the microphone ❶ will 

enable you to record a VoiceTrack link. 

 

RECORDING A VOICETRACKED LINK 

 

‘Voicetracking’ is a way to quickly produce a programme by dynamically inserting audio (normally voice 

links) between other items in the log in non-real time. By default, the last 10 seconds of the item you will 

be coming out of will be played enabling you to tailor the pacing of your link and the start of the next item 

can be fired off to do likewise into the next item. Once recorded you can also fine tune the segue to ensure 

it sounds the best it can.  

The process requires some setup on whichever mixer desk you are using as you want to send to the 

recorder only your voice and not the songs you are coming out of or into. This is normally achieved by de-

routing the Myriad Playout faders from the record ‘bus’ enabling you to hear the audio but it not be 



recorded. By only recording your 

voice you can move the link 

around within the segue without 

strange phasing issues 

happening. 

 

 

 

 

 

 

 

To Record a Voice Track link 

1. Highlight the Song / Link that you want to be playing at the end of your voice link. 

2. Click on the SegEdit button. 

3. Press the spacebar or click on the microphone icon and the end of the Song / Link you will be talking 

out of will start playing. 

4. Put up the mic channel fader on your desk and start speaking at the suitable point, Myriad Playout 

can be automatically set to start recording (if you have this configured in your settings). 

Alternatively, press the spacebar to start recording (or click on the Red Record Icon) 

5. Press the spacebar to start the next Song/Link playing when you are ready. 

6. At the end of your vocal link, press the spacebar to stop recording.  

If you are talking into an ad break you will need to press the spacebar twice in short succession. 

You will then be asked whether you wish to save the Voice Link. If you select ‘No’ you can redo your link 

and the recording will be deleted. If you want to keep it. 

7. Hit spacebar one final time will confirm that you want to save and you have finished recording your 

Voice Link. 

You can now edit this segue and fade points of this Voice Link.  If you decide that you don’t like your link 

you can click on the X button (highlighted) and you will be asked if you wish to delete the Voice Link. You 

can choose Yes and it will be deleted from the MediaWall and the log or No and it will be removed from 

the log but still be on the MediaWall or you can click cancel to remove this box and go back to your segue.  

You can then leave the segue editor window up and select with the mouse the next log item you wish to 

talk out of and the segue editor window will update. 

When you have completely finished voice tracking items, close the segue editor window using the x in the 

top right of the undocked window. 



If you are doing a lot of Voice Tracking we recommend you use the Voice Tracking layout. This puts the log 

at the bottom and a docked Segue Editor at the top. 

 

 

 

 

 

 

 

 

 

We hope this has given you a good overview of Myriad Playout v5 and more documentation and videos are 

available on our website broadcastradio.com.  

http://www.broadcastradio.com/

